
Microsoft Combat Flight Simulator 3:  
The Battle for Europe 

README FILE 
© Copyright 2002, Microsoft Corporation. All rights reserved. The names of actual companies and products 

mentioned herein may be the trademarks of their respective owners. 

Thank you for purchasing Microsoft® Combat Flight Simulator: The Battle for Europe (CFS3). 

This README file provides late-breaking information that was not included in the Handbooks 

or onscreen Help for CFS3. 

For additional information, be sure to visit the CFS3 Insider Web Site at  

http://www.cfsinsider.com where you will find news, articles, and tips on how to get the 

most out of CFS3. 
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Note: If you have just installed CFS3 and are using antivirus software, performance problems 

may result if you start CFS3 immediately. Please give your antivirus software time to scan the 

newly installed files. 

1. Documentation and Help Issues 

Quick Reference Card 

The Quick Reference Card incorrectly assigns Yaw right (rudder) to Num Pad ENTER. To yaw 

right, press Num Pad 3. 

Getting Started Booklet 

The Flight Recorder function referred to in the Getting Started booklet is not available in CFS3. 

Internet Explorer Issues 

The CFS Help system will not show air combat maneuver training movies if Internet Explorer 

4.0 is installed on your machine. It may also not play on some Windows 98 machines with 

Internet Explorer 5.0. To view the training movies, install IE version 5.5 or greater (for more 
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information on installing the current version of IE, see 

http://www.microsoft.com/windows/ie/default.asp). 

2. Gameplay Issues 

Tracers And Gunsights 

When you fire guns from the turret positions within aircraft, the tracers may not line up precisely 

with the gunsight.  

Campaign Headquarters Transfers 

In campaigns, you may want to transfer the headquarters (HQ) your squadron is assigned to in 

order to improve your position along the front. Note that you can only transfer to HQs that are of 

the same nationality as your pilot. For example, if you are a British pilot, you can only transfer 

your squadron to another British HQ, not to an American HQ. 

Warp 

Warp quickly moves your aircraft to the next waypoint or objective. To do this, the autopilot 

flies your aircraft so that it arrives at precise waypoints. For example, you may be at 20,000 feet, 

but the process of warping may leave you at 6,500 feet. This happens because the waypoints 

have a specified altitude (here, 6,500 feet), and warp is flying your aircraft to arrive at that 

altitude. 

Also, please note that if you activate warp while you are in a tight turn or some other maneuver, 

you may come out of warp in a disoriented position. You should only activate warp while flying 

straight and level. 

Tactical Display 

Although the tactical display may look like “radar,” it in fact reflects your pilot’s visual 

capabilities. Objects will only appear in the tactical display if they fall within the visual range of 

your pilot. 

Goal Text 

When flying over a mission goal target, you will see purple text that floats over an object. This 

purple text contains a percentage that represents the percentage of the goal left remaining (not 

the amount of “health” of the object that the text is floating over). For example, if your goal is to 

destroy two ships in a group of ships and you completely destroy one ship, the text will read 

“50%”. 

Turning Off An Engine 

To turn off an aircraft engine, lean the mixture out so that the engine shuts off. To do this, press 

Ctrl+Shift+F6. 

Jettisoning Drop Tanks Or Ordnance 

The CFS3 Help system indicates that to jettison empty drop tanks or other ordnance you must 

press SHIFT+J; however, jettisoning is really a two-step process. To jettison ordnance: 
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1. Press SHIFT+S to select the weapon to jettison. 

2. Press CTRL+J to actually jettison the weapon. 

To jettison drop tanks, press Ctrl+Shift+D. 

Understanding Checklist Values And Ranges 

Note that we have rounded checklist values, and included ranges of numbers. This allows for 

slight performance differences among aircraft variants, whose numbers may differ slightly. 

Single Players Are Always In The Lead Aircraft 

Users in single-player mode are always flying the lead airplane in the formation. 

Reloading Rockets 

Note that even when you have chosen unlimited ammo, you will run out of rockets. This allows 

pilots to lighten their planes for air-to-air combat. To reload rockets, press Shift+J. 

Initial Delays In Displaying Checklists And Help 

Note that if you bring up an aircraft checklist or start the Help system for the first time while 

you’re flying, the game pauses for a number of seconds before it displays the checklist or Help. 

The second and subsequent times you display a checklist or Help, the game will not pause. 

Changing Views With The Hat Switch 

To toggle between panning and snap-to views with the hat switch, press the SCROLL LOCK 

key. 

Escort Missions In Quick Combat 

Enemy fighters in Quick Combat escort missions start at a distance and altitude relative to the 

bombers they are seeking to intercept, not to you; consequently, the “Enemies are 

advantaged/disadvantaged/neutral” radio buttons do not apply to these enemy fighters. 



3. Campaign Issues 

Time Acceleration 

In the upper left-hand corner of the CFS3 screen, you will see three “VCR-like” controls for 

manipulating the speed of the campaign. One button pauses the progress of the campaign, and 

the other two controls adjust the speed at which the campaign progresses. In general, it is best to 

fly missions as soon as possible to achieve the greatest impact on the front-line situation. 

However, you may want to accelerate time to allow injured pilots to heal. 

“Fog of war” 

You can view the Strategic Supply and Strategic Reserve levels of opposing nations in the game. 

You can also view how close an enemy is in a given sector to launching an offensive. However, 

the numbers assigned to these levels may not be completely accurate due to the “fog of war.” To 

decrease the fog of war, you may want to consider flying reconnaissance missions. 

Out-Of-Range Sectors 

If a sector is beyond the fuel range of your last-selected aircraft, you will only see one mission 

available for that sector: a Combat Air Patrol mission that takes place over your airbase or over a 

friendly facility. Whenever possible, it is better to choose sectors that you can reach with your 

aircraft in order to make more diverse and more effective missions available. 

Squadron Prestige 
Squadron prestige is the sum of the prestige earned by all pilots in a squadron. However, 

squadron prestige is calculated after you join the squadron. Even if your wingmen have 

accumulated personal prestige before you joined the squadron, your squadron will start over with 

zero prestige once you join it. 

Combat Air Patrol Missions 

Combat Air Patrol (CAP) missions in a campaign have waypoints where you must loiter for five 

minutes in order to fulfill that “waypoint objective.” Fulfilling this objective updates the 

waypoint. Like other campaign missions, CAP missions require that you fly all waypoints and 

end near your airbase in order to complete all mission goals.  

Quick-Load Keys 

You can use the following quick-load and save keys while you play a campaign: 

• F7 loads the most recently saved campaign game for the current pilot. 

• F8 opens the Load Campaign menu. 

• F9 opens the Save Campaign menu. 

Displaying In-Game Text 

To toggle between displaying or hiding in-game text (damage messages, advisor messages, etc.), 

press Shift+D. 



Age 

In campaigns, the Age setting simply sets the starting level of your pilot. If you specify an older 

age, your pilot will have a higher starting rank. 

4. Multiplayer Issues 

Gameplay 

In CFS3, it is possible to create games that are “unwinnable.” For example, if the spawn limit is 

set to a lower number, but the number of kills needed to win a game is high, the game may be 

unwinnable given the number of players in the game. You should use spawn limits only in 

conjunction with time limits as a game end goal. 

Team Dogfights 

With some team dogfights, in rare instances you may not see a score screen, which lets you enter 

the dogfight. To bring up the score screen manually, press Ctrl+Shift+S. 

Reloading Weapons 

You cannot reload bombs and rockets by pressing Shift+J in a multiplayer game. 

Restarting 

In multiplayer, if your aircraft is damaged and you land, your engines may no longer work, so 

you can’t take off again. If this happens, you must restart play by pressing Ctrl+Shift+K. 

Restarting destroys your current aircraft and lets you resume play in a new one. 

Player Names 

Some players may not be able to join games if there are 10 or more players already in the game 

who have the same name. To join such a game, use a different name. 

International Games 

When you play on a host server that uses a different language version of Combat Flight 

Simulator 3, some of the in-game messages will be in the language of that host server. 

Personal Firewall Software 

If you use personal firewall software on your computer, such as Zone Alarm or Sygate’s 

Personal Firewall, dialog boxes may pop up intermittently during the game. In some cases, one 

of these dialog boxes may appear behind the CFS3 window and cause the game to hang because 

the dialog box remains open. To switch to one of these open dialog boxes, press Alt+Tab. You 

can also configure your personal firewall software to always let CFS3 access the network. 



NAT And Firewall Issues 

If you cannot “see” the CFS3 Game List, and your computer is behind a Network Address 

Translation (NAT) or firewall machine, try opening ports on your firewall to enable gameplay. 

Specifically, in the Setup of your NAT/firewall, assign the following trigger ports to the 

coinciding public ports (note that all transmission is done using the UDP protocol).  

 

Trigger port Public port Protocol 

2300 28883 – 28886, 2300 UDP 

28883 UDP 28883 – 28886, 2300 UDP 

28884 UDP 28883 – 28886, 2300 UDP 

28885 UDP 28883 – 28886, 2300 UDP 

28886 UDP 28883 – 28886, 2300 UDP 

Other General Firewall Issues 

A client computer behind a firewall may not be able to join a password-protected game 

published using CFS GameMatch if the server for that game is behind the same firewall as the 

client. To connect to the game in this case, use the Join Private Game [Direct IP] option. 

If you connect to another computer behind the same firewall using CFSGameMatch, you may 

experience long connection times (up to a minute). For faster connection, connect directly to that 

computer. 

Windows XP Internet Connection Sharing 

A computer running CFS3 behind a Windows XP Service Pack 1 Internet Connection Sharing 

(ICS) Server may not be able to connect to a computer running behind a Windows XP ICS 

server. This is a known incompatibility between Windows XP service packs. To fix this problem, 

upgrade all Windows XP machines to the latest service pack. 

Windows 2000 Internet Connection Sharing 

A CFS3 multiplayer game running behind a Windows 2000 ICS server cannot connect to a game 

server hosted behind the same Windows 2000 ICS machine. To fix this problem, connect the 

clients directly to the server using the Join Private Game [Direct IP] option.  

Windows 98 Second Edition Connection Sharing 

You may experience extreme synchronization problems when connecting a Windows 98 Second 

Edition (SE) ICS server to a Windows 98 SE client that the ICS machine is serving. 

A CFS3 multiplayer game running behind a Windows 98 SE ICS server cannot connect to a 

game server hosted behind the same Windows 98 SE ICS machine. To fix this problem, connect 

the clients directly to the server using the Join Private Game [Direct IP] option.  

Clients external to your ICS network cannot connect to games hosted on a computer running 

Windows 98 SE if the ICS option is enabled on the host machine. 



Dual Network Interface Card/Internet Connection Sharing Issues  

If a CFS3 multiplayer game is hosted on a dual Network Interface Card/Internet Connection 

Sharing (NIC/ICS) machine, users with machines that are serviced by that dual NIC machine 

may not see the game in their game lists. The solution for this problem is to connect to the game 

host by specifying its IP address. 

Quick Chat Commands (for all players) 

In a multiplayer game you can type these messages on the chat command line: 

• /tell [username] [message] Sends a message to the player (username) you specify. 

• /reply [message] Sends a message to the last player who sent you a message. 

• /a [message] Sends a message to all players. 

• /f [message] Sends a message to players in your flight (all aircraft of your nationality). 

• /s [message] Sends a message to players in your section (all aircraft of the same type you are 

flying). 

• /ignore [username] Adds a player to your squelch list. 

Quick Host Commands (game host only) 

• /ban [username] Kicks out and bans a player you specify. 

• /unban [username] Removes a player from the ban list, which enables the player to re-enter 

the game. 

5. Graphics Issues 

Graphic Corruption When Using High Resolutions And/Or Color Depths 

It is possible to choose resolution and/or color depth settings for your card that require more 

memory than you have on your card, which can cause corruption. For example, you may see 

graphic corruption when running in 1600x1200x32 on an NVIDIA chipset-based video card. Or, 

you may see that terrain objects lose their color when you bail out of an aircraft. Other symptoms 

of graphic corruption include mixed, strange, or missing graphics on your aircraft or on the 

ground. To fix this issue, reduce the resolution and/or reduce the color depth. 

Graphic And Sound Corruption When Using High Image Quality Levels 

It is also possible to choose an image quality level that may be too detailed for your video card. 

If you do so, you may experience audio and/or video corruption along with low frame rates. To 

fix this issue, set a lower Image Quality level. 

General Problems 

Shifted Text After Changing Resolution 

When you switch resolutions within the game, some parts of the user interface may not display 

properly (text may shift). To fix this problem, close and reopen the dialog boxes affected. 

Improving Performance by Turning off In-Game Animations 



If you experience performance problems when using the game interface, quit the game and 

disable pre-flight animations. Note that this will disable your ability to preview aircraft before 

you fly. 

To disable pre-flight animations: 

1. Open Notepad (click Start on the Windows taskbar, click Programs, click Accessories, and 

then Notepad). 

2. On the File menu, click Open. 

3. In the Open dialog box, navigate to game.xml and open the file.  

Note: The location of this file depends on where you’ve installed the CFS3. The default 

location is, but most likely it will be at  

 C:\Program Files\Microsoft Games\CFS3\game.xml. 

4. In game.xml, change “ShowUIWorld=true” to “ShowUIWorld=false”. 

5. Save game.xml, and then run CFS3. 

HUD Gauges 

Some video cards (such as the S3 ProSavage) require textures that have square dimensions. The 

HUD gauge textures are not necessarily square, so you may see some graphic corruption in HUD 

gauges. 

Flickering Clouds or Other Graphic Anomalies 

With some video cards, clouds may appear to flicker or items may appear in front of other items 

when they should appear behind those items. To fix these problems, try using the CFS 

configuration application to enable high resolution z-buffers and disable dual-pass rendering as 

described in the following procedure. 

Note: The CFS3 configuration presets are designed for maximum compatibility with video 

cards. Changing individual settings within the CFS3 configuration is not supported and may 

cause your computer to stop responding or cause other problems. If you experience these 

problems, restore your configuration to its original state by opening the CFS3 configuration 

application and clicking Default Settings on the File menu. 

1. Open the CFS3 configuration application (click Start on the Windows taskbar, click 

Programs, and click the configuration application). 

2. On the File menu, click Custom Settings. 

3. On the Window menu, click Overrides. 

4. Make sure the Dual Pass Render check box is clear. 

5. Click to select the High Resolution Z-Buffer check box. 

6. Click OK, and then quit the CFS3 Configuration application. 

In-Game Animations 

Certain animations, such as propeller spin, may not work when you are in a gunner position and 

use the external view. 



Windows 2000 Drivers 

Many video drivers that run on Windows 2000 (especially those that also are designed to work 

with Windows NT® 4.0) were not designed to run with DirectX 8.0 and, therefore, will not run 

with CFS3. To fix this problem, download the newest drivers for your video card that are 

compatible with Windows 2000. 

3DFX Voodoo 3 Series Video Cards 

Rain and snow effects do not appear on systems with 3DFX Voodoo 3–based video cards. You 

may also experience “square” smoke. 

3DFX Voodoo 4 4500 Video Cards 

CFS3 may provide extremely low frame rates with this video card. If you experience low frame 

rates using this card, set the Cloud Detail level to 1.  

You may also experience odd patterns on airbases when you fly low (for example, expanded, 

striped concrete). To fix this problem, disable composite textures using the CFS3 configuration 

application. However, doing so degrades overall appearance of the terrain. 

3DFX Voodoo 5 5500 Video Cards 

CFS3 may display discontinuous “bands” when used with a Voodoo 5 5500 video card on 

Windows 2000 computers. To workaround this issue, use the 3DFx control panel to disable the 

second chip. 

You may also experience graphic corruption when you change your settings to use millions of 

colors [32-bit color]. Try using either a lower resolution or thousands of colors [16-bit color]. 

ATI All-In-Wonder 128 

CFS3 may display small triangles when used with an ATI All-in-Wonder 128 Pro.  

ATI Rage Fury Maxx 

On a Windows 98SE computer, some ground objects may flash as you fly over them. 

ATI Radeon 9700 Pro 

CFS3 may hang shortly after startup with the current version of drivers [as of October, 2002] for 

ATI Radeon 9700-series video cards. 

Matrox G400, G450 and G550 

Under Windows 2000 and Windows XP there are display problems using a Matrox G450 card. 

Aircraft, buildings, and terrain lose their coloring and are drawn all in white. You can mitigate 

this problem by leaving the Image Quality settings at 1 in the Display Options dialog box. 

In addition, if you change the color quality or display resolution within the game, you may 

experience strange colors in the game. To fix this problem, quit and restart CFS3. 



NVIDIA NForce Motherboards 

CFS3 may fail when used with NVIDIA NForce–based motherboards. To fix this problem, 

upgrade to the latest NVIDIA NForce motherboard drivers. 

With some NVIDIA NForce motherboards that have a video card in addition to on-board video, 

the game may stop responding. To fix this problem, use the NForce BIOS to disable the on-board 

video. 

NVIDIA Vanta TNT Cards 

If you are using a Vanta TNT video card with current reference drivers, the target cone may not 

change color. 

NVIDIA GeForce 4 TI4600 Cards 

You may experience display problems when running in Safe Mode on GeForce 4 TI4600 cards. 

To fix this problem, raise the Image Quality setting. 

PowerVR Kyro-Based Cards 

Computers using PowerVR Kyro series-based video cards cannot display high-detail (composite) 

terrain. If you are using this card, do not enable this feature.Turning this feature on will corrupt 

the graphics.  

S3 Savage 4 Chipset Video Cards 

CFS3 will only run in safe mode (with reduced graphics) on the S3 Savage 4 card under 

Windows 98, Windows ME, or Windows XP. CFS3  does not run with S3 Savage 4-based 

chipsets on Windows 2000. 

S3 ProSavage Chipset Video Cards 

With this card you may have problems seeing smoke through the propeller blades. 



Retail (in-the-box) Drivers And Video Cards 

The retail drivers that come with the following video cards exhibit display issues when running 

CFS3. You can solve these problems by updating to the latest reference drivers available from 

the chipset manufacturer. 

Card Recommended fix 

ASUS V7700 (GeForce 2) 

(Windows 98) 

Upgrade to the latest NVIDIA reference 

drivers. 

Guillemot Maxi Gamer Cougar Upgrade to the latest NVIDIA reference 

drivers. 

Hercules 3D Prophet (GeForce 

256) 

Upgrade to the latest NVIDIA reference 

drivers 

Hercules 3D Prophet II MX 

(GeForce 2 MX) 

Upgrade to the latest NVIDIA reference 

drivers. 

Hercules 3D Prophet II GTS 

(GeForce 2 GTS) 

Upgrade to the latest NVIDIA reference 

drivers. 

Hercules 3D Prophet II GTS Pro 

(GeForce 2 GTS Pro) 

Upgrade to the latest NVIDIA reference 

drivers. 

Hercules 3D Prophet 4000XT 

(Kyro) 

Upgrade to the latest PowerVR reference 

drivers. 

Hercules 3D Prophet 4500XT 

(Kyro II) 

Upgrade to the latest PowerVR reference 

drivers. 

Diamond Stealth III 540 (S3 

Savage 4) 

Upgrade to the latest S3 Graphics reference 

drivers. 

6. Sound Issues 

Crystal Audio Sound Cards 

The CFS3 display may suddenly go blank when using these cards. To fix this problem, use the 

following procedure: 

1. Click Start, and then click Run. 

2. In the Open box, type the following:  

dxdiag 

3.  Click OK, and then click the Sound tab. 

4. Under DirectX Features, move the Hardware Sound Acceleration Level slider all the 

 way to the left (the No acceleration setting). 

5. Click Exit. 

6. Try the simulation again. 

Aureal Vortex II Sound Cards 

You may experience delays between the audio and the game, and popping sounds, when using 

the drivers provided with this card. To fix this problem, upgrade to the latest audio drivers. 

No Sound Card 

If your computer does not have a sound card installed, you will not see advisor messages about 

wingman chatter in CFS3. 



7. Hardware Issues 

HP CD-Writer 8000+ 

If you are using this brand of CD drive, you may receive error messages that the CFS3 Disc 

cannot be found. 

8. Software Issues 

Antivirus Software 

Computers running antivirus software may experience longer load times when you start CFS3 

and when you open missions. If you experience unacceptable performance and you are using 

anti-virus software, temporarily disable the software before running CFS3. 

Ontrack Zipmagic 

You must disable the “Show Zip Folders” feature of Ontrack ZipMagic before running CFS3; 

otherwise, CFS may not function. 

9. Technical Support Options 

For all Microsoft support offerings, visit http://microsoft.com/support/  

In Canada, visit http://microsoft.ca/support/ 

 

To get started, try the following: 

• For articles targeted at specific issues, visit the Microsoft Knowledge Base at 

http://microsoft.com/support/ 

• To work with a Microsoft Support Professional over the Internet, submit your issue at  

http: //support.microsoft.com/directory/onlinesr.asp 

• For your product’s general support policy, visit 

http://support.microsoft.com/directory/productsupportoption.asp 

Phone Support: In the U.S., call (425)637-9308. In Canada, call (905)568-3503 (toll charges 

may apply). These numbers are for technical issues only; do not use them to request game hints, 

codes, or cheats. 

TTY Users: Microsoft text telephone (TTY/TDD) services are available at (425)635-4948 in 

Washington State, (800)892-5234 in the U.S., and (905)568-9641 (toll charges may apply) in 

Canada. 

Worldwide: Support outside the U.S. and Canada may vary. For regional contact details, visit 

http://microsoft.com/support/ 

Conditions: Microsoft’s support services are subject to then-current prices, terms, and 

conditions, which are subject to change without notice. 
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